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Lab Procedures

Attendance
Attendance is mandatory. Each student must complete all labs in order to receive a passing 
grade. If you miss a lab without prior notification of the instructor, you will be required to 
make up the lab subject to a 50% penalty in grade. No penalty will be imposed if an 
arrangement is made with the instructor prior to the lab.

Lab Preparation
Most labs require the preparation of a prelab which may involve a significant amount of 
work. The prelab must be completed prior to arrival at the lab. The prelab work will be 
graded as you enter the lab and is part of your lab grade.

Reports
Lab reports are due at the end of each lab. Each report must be written neatly and must be 
organized in a way that is easy to read. Each report must include the following information:

Lab #
Lab Title and Objective
Each procedure completely written out
Circuit diagrams
Truth table for combinational logic
Timing diagrams (if applicable)

Circuit diagrams must include IC# and gate# as shown in the diagram below. All pins must 
be labeled. Power and ground connections must be drawn. A legend listing all ICs (v.g., 
U1 7400 Quad NAND) must be a part of each circuit diagram. 
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LAB # 1

Logic Trainer

Purpose: To become familiar with the features and devices on the Logic Trainer. Learn how 
to document and wire a logic diagram. Learn how to use a logic probe.

1. Lab preparation
Verify that the logic expressions you plan to use are correct 
Prepare logic diagram that implements the logic expressions 
Check the diagram to have all features shown on the attached diagram
Develop a test procedure for the logic
Prepare a table with expected results and space for measured results

2. Logic Trainer - Learn how to use the following features of the Logic Trainer:
Power Switch
Power Supply terminals: +5 V (Vcc) & ground (do not use + 15 V and - 15 V)
Logic indicators
Data and Debounced switches
Clock: waveform and frequency selection
Breadboard connections: buses and tie points

3. IC Testing Station
How to read a chip part number
Identification of pin 1 of a chip
How to place a chip on the tester socket
How to test and interpret the result

4. How to wire a logic diagram
Containers with different sizes of wire 
How to place wires on the logic trainer  (check that power is off) 
Verify the connections against the logic diagram

5. Test the logic
Turn power on
Perform tests and document results
Analyze results and correct problems by debugging the logic

6. When to use a Logic Probe
Logic values and corresponding voltage ranges
What can the LED on the trainer detect
Levels detected by the Logic Probe 

7. Clean up
Turn off power to all devices
Remove wires and components from Digital Trainer
Return components to appropriate storage bins
Clean up the work bench



8. Logic Trainer Practice 
Test the IC chip selected by the instructor for the practice
Make the connections shown by your instructor on the digital trainer
Test the operation of the logic







LAB # 2

Combinational Logic with Basic Gates

Purpose: Evaluate the operation of basic logic gates. Use switches, LED lights and power 
supply on the Logic Trainer to test logic gates. Wire and test the logic 
implementation of a function. 

1. Logic operation of gates
In preparation for the lab, for each of the chips listed below prepare the following:
a. a logic diagram showing how switches and lights are connected to each chip. Show pin 

numbers, switch and light identifiers, and power supply connections.
b. prepare a truth table for testing one gate on each chip (list the expected result and 

provide space for  each measured result).
c. develop a test procedure that can be used to determine the logic level associated with an 

open input (i.e., not connected to Vcc or to ground).

Chips to be tested
7400 Quadruple 2-input NAND gates
7402 Quadruple 2-input NOR gates
7404 Hex inverters
7408 Quadruple 2-input AND gates
7432 Quadruple 2-input OR gates
7486 Quadruple 2-input XOR gates

During the lab, do the following:
a. wire each circuit in accordance with the logic diagram developed for the prelab. 
b. verify that all circuit connections are correctly implemented.
c. power up the logic and measure the data required for each table.
d. establish the logic level associated with an open input to each gate type.

2. Logic Implementation of a Boolean expression.  
In preparation for the lab, the Boolean expression below provides the logic required to turn 

on or off light L with any one of three switches A, B or C.  Changing the status of any one 
of the switches causes the light L to change state.

 
L = A B’ C’ + A’ B C’ + A’ B’ C + A B C

a. provide a logic diagram showing how switches, lights and logic gates should be 
connected in order to implement the expression above. Show gates (with pin numbers), 
switches, light and power supply connections.

b. prepare a truth table that shows the expected value of L for each state of the input 
switches. Provide space for entering the measured value of L for each input condition.

3. Discussion:

1. In which ways do chip manufacturers identify the location of pin 1 of a chip. 
2. Is the logic level associated with an open input the same for all gates?
3. Give a intuitive explanation of why the Boolean expression given for L makes sense.















LAB # 3

 Logic Implementation with One Gate Type

Purpose: Use NAND and NOR gates to implement AND, OR and NOT functions. 

1. Logic Implementation of a basic gates with NAND or NOR gates.  
In preparation for the lab, develop:
a. a logic diagram showing how the gates AND, OR and NOT can be implemented using:

a1. NAND gates
a2. NOR gates

b. prepare a truth table for testing each logic diagram
During the lab, do the following:
c. wire each circuit in accordance with the logic diagram developed for the prelab. 
d. test each circuit to verify its functionality.

>>> You may want to consider the chips shown on the next pages for parts 2, 3 and 4 <<<

2. Logic Implementation of a Boolean expression using NAND gates.  
In preparation for the lab  develop a logic diagram for the expression 

L = A B’ C’ + A’ B C’ + A’ B’ C + A B C
So that it can be implemented with NAND gates only. 
During the lab, do the following:
a. wire the circuit in accordance with the logic diagram developed for the prelab. 
b. test and debug the logic.
c. when the logic is functioning properly, call the instructor to verify its operation.

3. Logic Implementation of a Boolean expression using NOR gates.  
In preparation for the lab  develop a logic diagram for the expression 

L = A B’ C’ + A’ B C’ + A’ B’ C + A B C
So that it can be implemented with NOR gates only. 
During the lab, do the following:
a. wire the circuit in accordance with the logic diagram developed for the prelab. 
b. test and debug the logic.
c. when the logic is functioning properly, call the instructor to verify its operation.

4. Logic Implementation of a Majority gate.  
A majority gate produces an output 1 when the majority of the inputs are 1’s. The output 
becomes 0 when the majority of the inputs are 0’s.

In preparation for the lab  develop the logic for a 3 input majority gate using NAND gates. 
During the lab, do the following:
a. wire the circuit in accordance with the logic diagram developed for the prelab. 
b. test and debug the logic.
c. when the logic is functioning properly, call the instructor to verify its operation.









LAB # 4

 Logic Simplification with K-maps

Purpose: Use of the K-map to simplify logic expressions 

1. Division of a single digit BCD number by 5
A BCD digit can be represented by four bits (B3B2B1B0) with values 0 through 9. This 
number when divided by 5 will yield a one bit quotient (Q0) and a three bit remainder 
(R2R1R0).

In preparation for the lab design a logic that accepts the BCD number (B3B2B1B0) and 
compute the quotient (Q0) and the remainder (R2R1R0) resulting from a division by 5. As 
part of your design provide the following:

a. a truth table with columns corresponding to B3B2B1B0, Q0 and R2R1R0.
b. K-maps to obtain a logic expression for Q0, R2, R1 and R0 in terms of B3B2B1B0. Be 

sure to take advantage of don’t cares to simplify the logic.
c. a logic diagram that uses NAND gates and inverters to implement the logic expressions 

obtained in part b. Use switches for entering the BCD number and LED lights to display 
the quotient and the remainder.

 
During the lab, do the following:
d. wire the circuit in accordance with the logic diagram developed for the prelab. 
e. test and debug the logic.
f. when the logic is functioning properly, call the instructor to verify its operation.

2. A Full-Adder Cell
A full-adder cell allows the addition of two bits (xi 
and yi) with a carry (ci) from a less significant two 
bit addition and produces a sum (si) and a carry 
(ci+1) for a more significant two bit addition. The 
operation and the corresponding truth table are
shown aside. 

In preparation for the lab design the logic to accept ci, x i  and yi 
as input and to compute the outputs si  and ci+1. As part of your 
design provide the following:

a. K-maps to obtain a logic expression for si  and ci+1  in terms of 
ci, x i  and yi .

b. based on the chips available on the lab provide a logic diagram that will implement a 
Full-adder cell with a minimum number of chips.

c. obtain a truth table for the expected value of s i  and s i in terms of c i, x i and y i  

During the lab, do the following:
d. wire the circuit in accordance with the logic diagram developed for the prelab. 
e. test and debug the logic.
f. when the logic is functioning properly, call the instructor to verify its operation.

c i+1 s ic i  x i  y i

0   0   0
0   0   1
0   1   0
0   1   1
1   0   0
1   0   1
1   1   0
1   1   1

0 0
0 1
0 1
1 0
0 1
1 0
1 0
1 1

c i+1 s i

c i 
x i
y i +



LAB # 5

 Programming Logic with Verilog

Purpose: Learn how to to enter, simulate and debug logic expressions using VeriWell.

1. An Example of Combinational Logic
In preparation for the lab study the Verilog program listed below and:

a. extract the logic expression that is being implemented by the “logic1” modules.
b. explain what Verilog models were used to implement logic1 in Model A and Model B
c. obtain a truth table for the expected value of d in terms of a, b and c 
d. explain what the instruction   {a,b,c} = count    does
e. describe the function of $display and $monitor

module stimulus; // tested for module logic1reg a,b,c;
reg [2:0] count;
wire d;

// instantiate the module logic1
logic1 trylogic(d,a,b,c);

// use count to assign values to a,b and c
initial 

count = 3'b0; // set count = 0

always
  begin

{a,b,c} = count; // assign values to a,b and c
#5 count = count+1; // compute next set of values

  end
  
initial

#40 $finish; // terminate the simulation

// display the value of inputs and output
initial
  begin    $display("                time ","a ","b ","c ","d");

$monitor($time," ",a," ", b," ", c," ", d);
  end

endmodule

module logic1(W,X,Y,Z);  //   model A
output W;
input X,Y,Z;
wire P,Q;

not(P,Y);
or(Q,X,P);
and(W,Q,Z);

endmodule



/*
module logic1(W,X,Y,Z);  //   model B

output W;
input X,Y,Z;

assign W = (X || !Y) && Z;
endmodule
*/

During the lab, do the following:
a. copy the code of this program from the server into your account 
b. run the Verilog program with model A using VeriWell 
c. print the Verilog program and the results of the simulation on the VeriWell Console 
d. ask the instructor to verify your results and initial your listing.
e. do steps b. through d. using model B.

2. Majority gate Implementation with Verilog
In preparation for the lab develop the logic for a 3 input majority gate using:

a. Verilog behavioral model (use assign, &&, || and ! to enter logic expressions)
b. Verilog gate model (use built in NAND function)
c. a stimulus program to test the models developed in parts a and b.

During the lab, do the following:
d. program the logic developed for the prelab. 
e. test and debug the logic.
f. when the logic is functioning properly, call the instructor to verify its operation.
g. document the source code with comments
h. print the source code and the test output

3. Full-Adder Cell Implementation with Verilog
a. use the information provided in lab 4.2 to develop a behavioral model for a Full-Adder  

(use assign, &&, || and ! )
b. design a stimulus program to test the models developed in part a.

During the lab, do the following:
c. program the logic developed for the prelab. 
d. test and debug the logic.
e. when the logic is functioning properly, call the instructor to verify its operation.
f. document the source code with comments
g. print the source code and the test output



LAB # 6

 Logic Implementation with a PLD

Purpose: Learn how to use Quartus to enter, simulate, program and test logic expressions 
on a PLD using the Programmable Logic Unit (PLU).

1. Logic Entry with Quartus
a. Use Windows Explore to create a folder “Lab6a” inside the folder “CPEN230L” in the 

server under your account. Use Quartus to create a project by selecting
> File > New Project Wizard
    enter the path to the folder “Lab6a”

directory: n:\cpen230L\Lab6a
Project Name: Lab6a
Top-level Entity: Lab6a

use the “finish” button to exit the window

b. Enter Schematic
> File > New        -> Block Diagram/Schematic file  ->  OK (  *.bdf )
Expand the drawing window to full screen by pressing “Ctrl” “Alt” “space”.
Press the same set of keys to return to the original arrangement of windows.
Select a component
Left double click anywhere on the grided window. Enter under “Name” each of the 

following parts (one at a time) and “return”:
7404, 7411, not, and3, or4, gnd, vcc, input, output.

Place the components as shown in the figure Lab6a.
Delete the vcc and gnd by selecting the component and using “delete =>”.
Duplicate required gates by using copy and paste ctrl C, ctrl V
Use the tool        to connect the gates as shown in figure Lab6a. Observe that the      

tool can also be selected by left clicking the cursor at an input (or output) of a gate.
Assign a name to a line by right double clicking on the line and selecting “properties” and 

assign a name to an I/O pin by left double clicking on pin_name. Enter the names     
A, B, C, AN, BN, CN, LT    as shown in figure Lab6a.

Save the logic diagram (observe that the window name is changed to Lab6a.bdf).
Identify the PLD used for implementation 

> Assignments > Device 
Family: FLEX 10K     select under “Available Devices”

EPF10K20RC240-4 OK
Assign a PLD pin number to each input and output connector as shown in figure Lab6a 

by entering
> Assignments > Assign Pins
scroll the window to a row with the desired number - left click on that row
enter the pin_name on the window “Pin Name:”
click the button “Add”
repeat this procedure until all I/O pins are numbered then click OK.

Save the diagram
> File > Save 

Compile the project
> Processing > Start Compilation
observe the progress of the compilation on the window named “Module”.

Print the logic diagram
double click the entry “Lab6a” on the window “entity” to display the logic diagram.
> File > Print



2. Logic Simulation

a. Enter Input Waveforms
> File > New  > Other Files > Vector Waveform File    OK (  *.vwf )

select the “end time” and the “grid size”
> Edit > End Time     enter   10.0 us
> Edit > Grid Size     enter   1.0 us
> View > Fit in Window

enter input waveform Names
double click 1st line under Name

enter the Name:  A   OK
double click 2nd line under Name

enter the Name:  B   OK
..........
..........

double click next line under Name
 enter the Name:  LT     OK

enter the waveforms
left-click on the input symbol to the left of variable A  (this will cause the row 

associated with A to be highlighted). Left-click on the C-waveform on the tool 
palet. Select the “timing” tab and enter 

start time: 0 ps
end time: 10.0 us
count every: 1.0 us
multiplied by: 1 OK

do the same thing with B and C with the exception that 
for B set “multiplied by:” equal to  2
for C set “multiplied by:” equal to 4

save the waveform file

b. Compile and Simulate
> Processing > Start Compilation & Simulation
observe the process of the compilation and simulation on the module window
*** Errors may be detected that require correction ***
display the simulation results
> Processing > Simulation Report
expand the simulation window to fill the whole screen (Ctrl  Alt   space)
use the cursor the check the status of all variables at a selected time

left-click and hold-down on the little square box located at 0 ps just above the 
waveforms. Pull  the box along the time scale and observe the change in value of 
variables on the column “value” next to the column “name”.

reduce the size of the simulation window (Ctrl  Alt   space)

3. Download the logic configuration to the PLU
a. Set up the programmer

> Tools > Programmer
verify that 

the window next to the “hardware setup” shows “ByteBlaster [LPT1]”
the window next to the “Mode” shows “JTAG”.

b. Select programming file
click on the “add file” button and select the file “Lab6a.sof”
click on the square box under “Program/Configure” on the file description line. Observe 



that a check mark is added to the box.
turn on the power to the Programmable Logic Unit box.
observe that the green power light on the board is lit.
left-click the “start” button on the programmer window.
observe that the “configured” light on the board is now lit.

c. Test the logic
flip switches SW0 (196), SW1 (198) and SW2 (199) and observe the output in LT0 

(214).

4. A Full-Adder Cell
In preparation for the lab use the logic expressions developed in lab 4 part 2 to:
a. implement a Full-Adder cell using Verilog. 
b. check the functionality of the cell using VeriWell.

During the lab, do the following:
c. create the folder Lab6b and project Lab6b.
d. make the logic compatible with Quartus.
e. use the “create default symbol” from the “file” menu to 

modularize the logic into a virtual device named “FA”. 
This device shall have the inputs and output shown aside.

f. use Quartus simulator with appropriate waveforms to test 
and debug the logic. 

g. when the logic is functioning properly, call the instructor to 
verify its operation.

5. A 4-bit Adder using with Full-Adder Cells
In preparation for the lab do the following:
a. show how 4 FA modules can be interconnected to implement a 4-bit adder
b. develop a logic diagram for the PLU that will allow testing the 4-bit adder. Use switches 

0-3 for x and switches 4-7 for y. Lights 0-5 shall be used for the result.

During the lab, do the following:
c. create the folder Lab6c and project Lab6c.
d. program the 4-bit adder. Use 4-bit busses for the inputs x and y, and for the output s. 

Create a symbol for the 4-bit adder. Connect the adder to PLU lights and switches.
e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.

FA
c i 

y i 

c i+1
x i 

s i



LAB # 7

 Keypad Decoder

Purpose: Use Verilog and Quartus to design a decoder that translates 2 out of 7 keypad 
signals into a 4-bit binary value and a valid entry signal.

A diagram of the keypad on the Programmable Logic Unit is shown below. The terminal COM 
is connected to ground and the terminals linked to rows and columns have pull up resistors.

1 2 3

4 5 6

7 8 9

* 0 #

COM
C2

C1 C3
R1

R2
R4 R3

1 2 3

4 5 6

7 8 9

* 0 #

COM
C2

C1 C3
R1

R2
R4 R3

C2C1 C3

R1

R2

R4

R3

kp_decoder

C1

C2

C3

R1

R2

R3

R4

K3

K2

K1

K0

V

The decoder shall receive the active-low signals C1, C2, C3, R1, R2, R3 and R4 from the 
keypad and generate the active-high signals K3, K2, K1, K0 and V. The signals K3, K2, K1, K0 
shall provide the binary value of the key being depressed with K3 being the most significant 
bit. Depressing the keys 0 - 9, *, # shall produce the output 0000 - 1001, 1010 and 1011. 
When no key is being depressed or when only a row or a column is low, the value 1111 shall 
be output. The signal V when asserted indicates that a valid key has been depressed and that 
its value can be read on K3, K2, K1 and K0. The signal V shall not be asserted if no key or 
more than one key are depressed. Observe that the signal V, if debounced, can be used as a 
clock for entry of the data on outputs K3, K2, K1 and K0.

1. In preparation for the lab do the following:
a. obtain logic expressions for K3, K2, K1, K0 and V in terms of C1, C2, C3, R1, R2, R3 

and R4.
b. write the code in Verilog to implement the logic for decoding the keypad.

During the lab, do the following:
c. use Quartus to enter the keypad decoder logic. Encapsulate the logic into a module and 

create a symbol for the device and name it “kp_decoder” (see figure above).
d. connect the keypad decoder to the 7-segment display decoder. Display the V signal on 

the decimal point (pin 14) of the display. Use the V signal to blank the display when no 
key is depressed or if more than one key is depressed.

e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.



LAB # 8

 Addition and Subtraction 

Purpose: Design of an arithmetic unit that performs addition and subtraction. Use of 
multiplexors.

1. Design an 4-bit adder and subtractor 
This logic will allow the PLU to perform the operation C = A ± B. The value A shall be 
entered on switches SW0 - SW3 with SW0 being the most significant bit. The value B shall 
be entered on pushbuttons SW4 - SW7 with SW4 being the most significant bit. The 
result C shall be displayed on lights LT4 - LT7 with LT4 being the most significant bit. The 
operation shall be specified by switch SW8 (up = +, down = - ). A carry or borrow shall be 
displayed on light LT3.

In preparation for the lab
a. review the work done in part 5 of lab 6. Develop a logic diagram for the adder and 

subtracter (consider Figure 5.13 of the text) name this project Lab 8A .
b. develop a Verilog module named ADS that has two 4-bit input buses (A and B), an 

input operation selector line (S) and an 4-bit output bus (C). Use Quartus to interface the 
module ADS to the switches and lights name this Lab8B.

c. select test values to validate the operation of the two implementations of an adder and 
subtracter.

During the lab, do the following:
d. use Quartus to enter the logic for Lab8a
e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.
g. repeat steps d, e and f for Lab8b

2. Design an 4-bit BCD adder
Implement a 1 digit BCD adder using the logic shown in Figure 5.43 of the text. Use for 
inputs and outputs the same switches and lights specified in part 1.

In preparation for the lab
a. develop a logic diagram for the BCD adder using Quartus logic parts. Name this diagram 

Lab 8C.
b. select test values to validate the operation of the operation of the BCD adder.

During the lab, do the following:
c. use Quartus to enter the logic for Lab8C
d. compile, test and debug the logic
e when the logic is functioning properly, call the instructor to verify its operation.



LAB # 9

 Logic Implementation with MUX, DEMUX and ROM 

Purpose: How to use multiplexors, demultiplexors and ROMs to implement logic.

1. MUX Implementation of a Full-Adder cell 
Using the information provided in Lab 4.2 implement the expressions for s i and c i+1 using 
two 4-to-1 muxes.

In preparation for the lab
a. make a diagram for implementing the logic on the PLU with the following I/O assignment:

c i = PB2 x i = PB1 y i   = SW1 s i  =  LT1 c i+1 = LT0

b. prepare a truth table with the expected value of s i  and c i+1 in terms of c i, x i and y i   

During the lab, do the following:
c. use Quartus to enter the logic
d. compile, test and debug the logic
e. when the logic is functioning properly, call the instructor to verify its operation.

2. DEMUX Implementation of a Full-Adder cell 
Using the information used in part 1,  implement the expressions for s i and c i+1 using one 
demux and OR gates.

In preparation for the lab
a. make a diagram for implementing the logic on the PLU with the following I/O assignment:

c i = PB7 x i = PB6 y i   = SW6 s i  =  LT6 c i+1 = LT5

During the lab, do the following:
c. use Quartus to enter the logic
d. compile, test and debug the logic
e. when the logic is functioning properly, call the instructor to verify its operation.

3. ROM Implementation of a 4-bit to 7-segment HEX decoder Design 

In preparation for the lab
a. develop a minterm expression for each LED of a 7-segment 

display. The letter assignment for the display is shown aside. 
The HEX display shall be in accordance with the format shown 
below. 

b. Prepare a programming table for a ROM with 4 address lines
 and 7 data lines to implement the decoder.

c. Prepare a logic diagram in which switches SW0, SW1, SW2 

a

e

g b

cd

f



and SW3 (weights 8,4,2,1) can be used to enter a binary value to be displayed on LED 
display.

0 1 2 3 4 5 6 7 8 9 A B C D E F

During the lab, do the following:
d. use Quartus to enter the logic and program the ROM.
e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.



LAB # 10

 Latches, Flip-Flops and Counters

Purpose: How to use latches, flip-flops and counters. When to debounce a switch.

1. Set-Reset (S-R) Latch 
The figure below shows a S-R latch implemented with NOR gates.

PB0

PB1

LT1

LT0S

R

Q’

Q S    R        Q    Q’

    0     0
0     1
1     0
1     1

In preparation for the lab
a. fill in the truth table for this latch.
b. what combination of S-R inputs must not be allowed? If this condition is allowed to occur, 

will the latch be damaged? Could it introduce an error in the logic? Why?

During the lab, do the following:
c. use Quartus to enter the logic for the latch. Save the work as project Lab10a.
d. check that the latch performs as specified in the next state table.
e. when the logic is functioning properly, call the instructor to verify its operation.

2. J-K Flip-Flop 
The figure below shows a 7476 J-K flip-flop connected to switches and lights.

J     K        Q    Q’

    0     0
0     1
1     0
1     1

J

K

Q

Q
CK

PR

CLR

PB8

SW1

PB0

PB1

SW0

LT0

LT1

In preparation for the lab
a. fill in the truth table for this flip-flop.
b. which inputs have higher precedence J & K or PR & CLR? 
c. in order to use the J & K inputs what level should be applied to PR & CLR? 
d. on what edge of the clock do the inputs J & K get serviced? When will this happen, 



when PB8 is depressed or when it is released?
e. can this flip-flop be operated as a latch? How?
f. what is meant by switch bounce? Sketch the waveform of a signal produced by a closing 

switch. What flip-flop input is sensitive to a switch bounce?

During the lab, do the following:
g. use Quartus to enter the connections to the flip-flop. Save the work as project Lab10b.
h. check that the flip-flop performs as specified in the next state table and that the inputs PR 

& CLR function as expected.
i. observe that the flip-flop does not toggle consistently with the clock when J = K = 1. 

Explain why.
j. review with the instructor the operation of the flip-flop.

3. J-K Flip-Flop with debounced clock
The pushbutton providing the clock to the flip-flop will be debounced as shown in the figure 
below.

 During the lab, do the following:
a. create a new project on a new folder and name it Lab10c.
b. copy the files debounce1.gdf and debounce1.sym from  \\davinci\class\cpen230\library 

into folder Lab10c.
c. place the debounce1 logic between PB8 and the 7476 flip-flop wired for Lab10b as 

shown in the figure below.
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d. observe that the flip-flop toggle consistently with the clock when J = K = 1. 
e. when the logic is functioning properly, call the instructor to verify its operation.

4. Ripple Counter
A 4-bit binary counter will be tested using a pushbutton as the clock and a 7-segment 
display for monitoring the output.

In preparation for the lab
a. prepare a logic diagram showing how switch PB8 can be used to increment the count of a 

7493 counter. Use the debounce logic to make PB8 a clean clock. The output of the 
counter shall be connected to a 7-segment display using the 7-segment HEX decoder 
developed in part 3 of lab 9. Pushbutton PB9 shall be used to reset the counter.

b. design the logic required to convert this counter into a 0 to 9 counter. Pushbutton PB9 
shall still be able to reset the counter.

c. design the logic required to convert this counter into a 0 to 6 counter. Pushbutton PB9 
shall still be able to reset the counter.

d. does pushbutton PB9 require debounce logic?



 During the lab, do the following:
d. use Quartus to enter the logic.
e. check that the counter performs as expected.
f. when the counter is functioning properly, call the instructor to verify its operation.
g. convert the counter to a 0 to 9 counter using the logic developed in part b.
h. test the operation of the 0 to 9 counter. 
i. convert the counter to a 0 to 6 counter using the logic developed in part b.
j. test the operation of the 0 to 6 counter. 
k. connect the pushbutton PB8 directly to the clock input of the counter (bypass the 

debounce logic). Test the counter operation and establish if the debounce logic is 
needed for proper counting.

5. Verilog Implementation of a D Flip-Flop
The Verilog code for a D Flip-Flop is listed below.

module DFF(D, clk, Q);
input D, clk;
output Q;
reg Q;

always @(posedge clk)
      Q = D;

endmodule

In preparation for the lab
a. Design the logic required to test this Flip-Flop using SW0 for D, PB0 for clock and LT0 to 

display the output Q.

During the lab, do the following:
b. use Quartus to enter the Verilog code and the test logic.
c. compile, test and debug the logic
d. when the logic is functioning properly, call the instructor to verify its operation.



LAB # 11

 Registers 

Purpose: Use of registers to transfer and store information

1. Storing a keypad number

In preparation for the lab
a. modify the logic diagram developed for lab 7 by adding a parallel register to store the 

value of a key that is depressed. Consider using the 74175 register shown in the 
attached data sheet.

b. the signal valid signal (V) from the keypad decoder should be used as the clock for the 
register. It would be wise to debounce this signal.

c. the output of the register shall be displayed on a 7-segment display using a 7-segment 
display decoder (7448).

During the lab, do the following:
d. use Quartus to enter the logic developed in parts a through c.
e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.
     

2. Modes of operation of a shift register

In preparation for the lab
a. study the operation of a 74195 shift register. Examine the device input/output signals 

and the function table shown on the data sheet. The device has two modes of operation: 
parallel loading and serial shifting. Parallel loading is illustrated in the 2nd row of the function 
table. Right shifting is shown in the 5th and 6th rows of the table.

b. prepare a logic diagram showing how the shift register can be controlled with:
SW8 - mode switch 0 = parallel load, 1 = right shift
SW0 through SW3 - data for parallel inputs A, B, C, D
PB8 - when pressed will cause either a parallel load or serial right shift as specified 

by SW8. Why should this signal be debounced?
The parallel outputs QA, QB, QC and QD of the register should be displayed on the 
lights LT0 through LT3.

c. develop a plan for testing parallel loading followed by serial shifting of data.

During the lab, do the following:
d. use Quartus to enter the logic developed in parts a through c.
e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.
     

3. Serial transfer of data between registers
The information obtained in part 2 will be used to implement the transfer of data from 4 
switches to 4 lights one-bit-at-a-time through serial transmission between registers. Two 
74195 shift registers will be required: one to accept parallel data and transmit this data 
serialy and the other to receive the serial data and present this data through a parallel output.



In preparation for the lab
a. prepare a logic diagram showing how the two shift registers can be controlled with:

SW8 - mode switch 0 = parallel load, 1 = right shift
SW0 through SW3 - data for parallel inputs A, B, C, D
PB8 - when pressed will cause parallel load or serial shift as specified by SW8.

The parallel outputs QA, QB, QC and QD of the transmisison register should be 
displayed on the lights LT0 through LT3. The parallel outputs QA, QB, QC and QD of 
the receive register should be displayed on the lights LT4 through LT7. 

b. in your design, carefully consider the fact that latching of data on the receiver should occur 
prior to a data shift on the transmitter. Keep in mind that a pulse has two edges: a positive 
edge and a negative edge!

c. develop a plan for testing parallel loading followed by serial shifting of data.

During the lab, do the following:
d. use Quartus to enter the logic developed in parts a through c.
e. compile, test and debug the logic
f. when the logic is functioning properly, call the instructor to verify its operation.
     



Lab Project

Electronic Combination Lock

The lock shall accept three digits (0 - 9) entered through the keypad and compare them with 
three internally stored numbers. The logical signal OPEN shall become true if the numbers 
entered agree in order and value with those internally programmed. The lock shall be disabled 
if the numbers entered do not agree in value or order with those internally programmed.

Part 1 - Basic Lock

Inputs:
KP (number) - keypad for entering numbers (0 - 9)
PB9   (CLEAR) - for clearing the entry of numbers (only allowed after 1st or 2nd digit)
PB0 (RESEN) - restricted access reset enable

Outputs:
LT 0 (RESET) - reset state - no numbers have been entered 
LT 1 (INUSE) - one or two values have been entered 
LT 2 (OPEN) - the lock is open. The lock will remain open for  only 3 seconds.
LT 3 (DISABL) - indicates that the lock has been disabled. The RESEN pushbutton must 

be on in order to enable the CLEAR pushbutton.
MS7 - most significant “Flex-digit” 7-segment display on the UP-1 board.
LS7 - least significant  “Flex-digit” 7-segment display on the UP-1 board.

Specifications:
1. The lights LT0, LT1, LT2 or LT3 shall be used to indicate the status of the lock.Only one of 

the lights shall be on at any time.

2. Digits are entered through the keypad KP.After 3 digits are entered the lock must become 
either OPEN or DISABLED. 

3. Display on the MS7 display the number of digits entered (0, 1 or 2). This display shall show  
0 when the lock is in the RESET state.

4. When the correct combination ( 3 5 7 ) is entered, the light OPEN shall remain ON for 3 
seconds after which the lock goes to RESET.  

5. If less than three digits are entered, depression of the CLEAR button will cause the lock to 
go into its RESET state. 

6. The lock shall become DISABLED when three digits are entered and at least one of them is 
incorrect. 

7. A DISABLED lock can be reactivated by pressing the restricted access RESEN 
pushbutton and the CLEAR pushbutton simultaneously.

8. The lock shall timeout and RESET if the second and third digits are not entered within 5 
seconds of the first digit. 



Part 2 - Enhanced Lock

Design of this lock shall not take place until an implementation of the Basic Lock has been 
completed and shown to meet all specifications.

Additional Inputs:
PB4 (PRGEN) - enables entry of a new combination for the lock
PB5   (DISPL) - enables the combination of the lock to be displayed on LS7

Additional Outputs:
LT 4 (PROG) - combination being programmed 
LT 5 (DISPL) - combination being displayed

Specifications:
1. When the lock is in the RESET state and the restricted access pushbutton PB4 (PRGEN) is 

depressed, light LT4 shall go on, light LT0 shall go off and three digits entered on the 
keypad shall be stored as the combination for the lock. After the third digit is entered the lock 
shall return to its reset state. If three digits are not entered within 5 seconds of PB4 being 
depressed, the lock shall return to the RESET state and the combination remains 
unchanged. MS7 shall indicate how many digits have been entered (0, 1 or 2).

2. When the lock is in the RESET state and the restricted access pushbutton PB5 (DISPL) is 
depressed,  light LT5 shall go on, light LT0 shall go off and the combination of the lock shall 
be displayed on LS7 each digit for 1 second. MS7 shall display the sequence number of 
each digit (1, 2, 3). The lock shall then return to its reset state and the display shall go blank.

3. Operation of the Basic Lock, programming a new code and displaying the combination shall 
be designed as mutually exclusive functions that are enabled when the lock is in the RESET 
state. Possible conflicts shall be resolved in terms of the following priorities:

DISPL > PROG > Basic Lock

When the Basic Lock is being controlled and either PB4 or PB5 are pushed, the operation 
of the Basic Lock will continue. Pushbuttons PB4 and PB5 are only recognized when the 
lock is in the RESET state. Likewise, when a new combination is being programmed, a 
depression of PB5 shall be ignored.



CPEN 230

Project Development Cycle

Requirements
Description of the purpose for the device
Specifications - how well the device must perform
Deliverables - what will be provided at the end of the project

Conceptual Design
Functional Description of Operation
Block Diagram
Truth Table
Algebraic equations
State Diagram
Timing Diagram

Detailed Design
Schematic Diagram
Wiring Diagram
Parts List
Layout Diagram

Test Procedure
Test Plan
Test Scripts

Documentation
User’s Manual
Maintenance Manual



Appendices

Elenco Logic Trainer - Schematic Diagram

B & K Logic Probe - Schematic Diagram

Logic Gates used in the Lab

PLU Wiring Diagram

Altera’s UP 1 Pin Assignments


